To successfully create a Web site, schools and jurisdictions must plan for the site's content, design and development and learn the principles of effective page design. This report contains technical advice on implementing and managing Web site development in schools. Following an introduction which discusses functions of jurisdiction and school Web sites, the report outlines things to consider when creating a Web site, including content, design and development, and copyright and other legal responsibilities. The report then focuses on planning a Web site, effective page design, and intranets and Web servers. In addition, the report lists 34 Web site development resources, many of them on-line, 13 references, and a glossary of terms. Appendices include file naming conventions, sample lesson plans for creating a Web page using Publisher 97, HTML, and Word 97, points of interest resources, resources for teachers, and related Alberta Education resources. (AEF)
IMPLEMENTING AND MANAGING WEB SITE DEVELOPMENT IN EDUCATION

Best Practices
For Alberta School Jurisdictions

March, 1999
Introduction

The primary intended audience for this framework is:

- Administrators
- Counsellors
- General Audience
- Information Technologists
- Parents
- Students
- Teachers

Copyright © 1999, the Crown in Right of Alberta, as represented by the Minister of Education. Alberta Education, School Technology Task Group, 11160 Jasper Avenue, Edmonton, Alberta, Canada, T5K 0L2.

Permission is given by the copyright owner to reproduce this document, or any part thereof, for educational purposes and on a nonprofit basis.
ACKNOWLEDGEMENTS

Alberta Education wishes to acknowledge the contributions of the following individuals.

PROJECT DIRECTOR

Edna Dach
Director, Technology Services
Elk Island Public Schools Regional Division No. 14

AUTHORS

Linda Adamyk
Elk Island Public Schools Regional Division No. 14
Edna Dach
Elk Island Public Schools Regional Division No. 14

COMMITTEE MEMBERS

Barbara Brown
Edmonton Catholic Schools Regional Division No. 40
Lonnie Springer
Calgary Roman Catholic Separate School District No. 1

SCHOOL TECHNOLOGY ADVISORY COUNCIL MEMBERS DURING DEVELOPMENT

John Travers (Chair)
Alberta Education
Peter Balding
Black Gold Regional Division No. 18
Marika Bourque
Calgary School District No. 19
Bonnie Brooks
Alberta Education
George Buck
Universities Co-ordinating Council
David Burch
Alberta Home and School Councils’ Association
Edna Dach
Elk Island Public Schools Regional Division No. 14
Jack Dale
Calgary School District No. 19
Peter Darby
Chinook’s Edge School Division No. 73
John Darroch
Palliser Regional Division No. 26
Dale Erickson
College of Alberta School Superintendents
Chris Farthing
Edmonton Catholic Regional Division No. 40
Toni Hafso
Alberta Education
Gary Heck
Lethbridge School District No. 51
Harry Henshaw
Alberta Education
Robert Hogg
St. Albert Protestant Separate School District No. 6
The Alberta Teachers’ Association
Maurice Hollingsworth
Palliser Regional Division No. 26
Judi Hunter
Calgary School District No. 19
Glen Johnson
Edmonton School District No. 7
Doug Knight
Alberta Education
Catherine Kullman
TELUS Learning Connection
Norma Nocente
Universities Co-ordinating Council
John Percevault
Grande Yellowhead Regional Division No. 35
Archie Pick
Alberta Chamber of Resources
Doug Pudwell
Medicine Hat School Division No. 76
Association of School Business Officials of Alberta
Randy Rudd
Pembina Hills Regional Division No. 7
College of Alberta School Superintendents
Ralph Schienbein
Jacqueline Skytt
Ron Sohnle
Gary Spence
Lonnie Springer
Mary Stephenson
Barbara Stevenson
Paul Stevenson
Arwin van Voorthuizen

Elk Island Public Schools Regional Division No. 14
The Alberta Teachers' Association
Alberta Education
Wolf Creek School Division No. 72
Calgary Roman Catholic Separate School District No. 1
Alberta Chamber of Commerce
Calgary School District No. 19
The Alberta Teachers' Association
Horizon School Division No. 67
Alberta College of Art
Council of Presidents of Public Colleges and Technical Institutes of Alberta

RESOURCE PERSONNEL

John Hogarth
Peter Wright
ConsultNet
University of Alberta
# TABLE OF CONTENTS

Executive Summary ........................................................................................................ 1
Introduction .................................................................................................................... 3
  Functions of Jurisdiction and School Web Sites .......................................................... 3
Creating a Web Site: Things to Consider ....................................................................... 7
  Content, Design and Development ............................................................................ 7
Copyright and Other Legal Responsibilities ................................................................ 10
  Copyright .................................................................................................................. 10
  What is Copyright? ...................................................................................................... 11
  What Does Copyright Apply To? ................................................................................ 11
  Who Owns the Copyright? .......................................................................................... 11
  How Can Teachers Legally Use Material Protected by Copyright? .......................... 12
Freedom of Information and Protection of Privacy ...................................................... 14
The School's Legal Responsibilities ............................................................................ 15
Planning a Web Site ...................................................................................................... 17
Effective Page Design .................................................................................................. 21
Intranets and Web Servers ............................................................................................ 25
Conclusion ..................................................................................................................... 29
Web Site Development Resources .............................................................................. 31
  On-line Resources ...................................................................................................... 31
  Commercial Resources ............................................................................................... 34
References ...................................................................................................................... 35
Glossary of Terms .......................................................................................................... 37
Appendix A: File Naming Conventions .................................................................... 43
Appendix B: Sample Lesson Plans for Creating a Web Page .................................. 45
  Creating a Web Page Using Publisher 97 .................................................................. 45
  Creating a Web Page Using HTML .......................................................................... 46
  Creating a Web Page with Word 97 .......................................................................... 54
Points of Interest Resources ....................................................................................... 59
Resources for Teachers ................................................................................................. 59
Appendix C: Related Alberta Education Resources ..................................................... 61
EXECUTIVE SUMMARY

The World Wide Web is quickly becoming a resource for schools, and many are now establishing their own web sites. There are various reasons for establishing a school or jurisdiction web site, but in most cases the goals are all related in some way to three key functions: curriculum, communications and marketing. Some typical curricular functions (web site activities that support learning) include providing instructions about participating in a project, showcases for student work and “tele-field-trips.”

To successfully create a web site, schools and jurisdictions must take the following steps:

1. **Plan for the site’s content, design and development.** Who will take ownership of the web site? What will be posted there? How large should the site be? Who is the intended audience? What will the site look like? How will security issues be handled? What about legal responsibilities (copyright, complying with the Freedom of Information and Protection of Privacy Act), avoiding libel and slander suits, conforming to the values of the community)?

   These are just some of the many important issues a web site developer has to consider carefully. Another one is finding the required expertise and budgeting for the costs involved. (Setting up the site is just the beginning—it also must be maintained and kept current.)

2. **Learn the principles of effective page design.** Since the Web is quite a different (highly visual) medium from printed communications, using graphic design effectively is a critical factor in the site’s success. This best practices report provides a variety of useful tips about accessibility, consistency, templates, footers and headers, fonts, graphics, sound and video, and more.

This report contains useful technical advice; for example, on using intranets and web servers to host school or jurisdiction web sites, and on using different types of software to create a web page. It also lists extensive web site development resources, many of them on line, and includes an extensive glossary of technical terms.
INTRODUCTION

FUNCTIONS OF JURISDICTION AND SCHOOL WEB SITES

Today, schools are accessing a new resource to enhance student learning—the World Wide Web (WWW), which links information and resources from anywhere and allows students to go beyond the four walls of their classroom. The WWW is a subset of the Internet that uses HyperText Transfer Protocol (HTTP) and hypermedia languages like HyperText Markup Language (HTML). The purpose of this report is to help school jurisdictions and schools develop a presence on the World Wide Web by exploring and learning from the best practices of those who have already blazed the trail.

A web site is a home address for an individual or organization on the World Wide Web. Web sites—properly constructed—are information systems. They efficiently structure content to provide visitors with knowledge and insight. They also may serve as interfaces, providing bridges and translations to connect users to other experiences. A good web site helps people to quickly find educationally worthwhile information.

Given the capacity to launch a web site, the question logically becomes..."Why bother? Why place a web site on line?" Jamie McKenzie (January 1997) lists four main goals for a web site:

1. to introduce visitors to the school jurisdiction or school—its mission, character, look, offerings to children, stance on new technologies and overall spirit,
2. to point to excellent information on the larger Web—identifying resources that are most likely to support the curriculum and the kinds of investigations likely to be undertaken by staff and students,
3. to offer an opportunity for publishing staff or student works (art, music or writing) to a local and global audience, and
4. to provide rich, locally collected data on curriculum-related topics (such as local history) in the form of data warehouses, virtual museums or virtual libraries.

Some web sites include all four of these elements, but most concentrate on two or three.

A web site provides jurisdictions with a new means of communicating the latest information (e.g., handbooks, curriculum information, and annual reports) to a wider audience. Many school jurisdictions in Alberta have developed a web site to give parents information about the school, describe instructional programs, state the school mission and so on. Forms and e-mail features can be used to gather information and feedback from parents and visitors to the site.

A web site also can be used to support instruction or provide information about learning resources. Many schools seek ways to engage students in real-world problem solving, and web sites can offer a vehicle to support such studies. This type of web site can save staff and students hours of searching by listing only Internet locations that offer developmentally appropriate and relevant content. A good example is the TELUS Learning Connection site <www.2learn.ca>, which offers excellent links to curriculum-related resources.
Many good examples of educational telecomputing projects that are supported by web pages are accessible at <http://teach.virginia.edu/go/mining/97/feb/>. These links are organized both by web page functions and by activity structures. Aspects of a few of these WWW documents are examined here to illustrate different functions of an educational web site project. (Much of the information included in this section is drawn from Dr. Judi Harris' National Educational Computing Conference [NECC] '97 presentation.)

1. Project Overview

Web sites can succinctly introduce people to the goals of and operational structures for educational telecomputing projects. For example, the Canadian Kids from Kanata project <http://www.web.apc.org/KFK/kfkhome.html> home page contains a brief history of the project; an explanation of how the communicating groups are organized; summaries of praise the project has received; supporting organizations and individuals; and links enabling visitors to fill out an application to participate and/or to e-mail organizers with questions. The purpose of the site is to encourage communication among indigenous peoples and later immigrants.

2. Project Announcement

A web site can announce curriculum-based projects. The U.K.-based Chatback project collection <http://spectrum.tcns.co.uk/chatback/welcome.html> sponsors memories from 1945. It helps senior citizens to communicate with students about their memories of World War II.

3. Project Instructions

Web sites can provide telecollaborators with specific instructions about participating in an education project. I*EARN, an organized global classroom project at <http://www.iearn.org/iearn/circles/lc-home.html>, is supported by a hypertextually linked set of carefully crafted and information-rich web pages that provide specific, step-by-step instructions. The page also contains information on joining I*EARN, links to conferencing spaces in which project partners communicate and a chronologically organized timeline for the first session of Learning Circle.

4. Information Repository and Exchange

Web sites can serve as virtual places for project participants to exchange information. For example, KIDLINK's long-term Multi-Cultural Calendar database creation project site at <http://www.kidlink.org/KIDPROJ/MCC/> contains cross-indexed, student-written depictions of hundreds of holidays and festivals around the world. The holiday descriptions are accessible by month, holiday name, country and author. A web-based form also is available at the site, so that new entries for the holiday database can be submitted more easily.
5. Context for Project-Related Communication

Web pages can be co-constructed by project participants, creating an open-ended form of multimedia communication. The Electronic Emissary telementoring project at <http://www.tapr.org/emissary/> helps to match volunteer subject matter experts with students and teachers interested in inquiry-based learning in the experts' areas of specialization.

6. Project Support

Web sites can serve as organized collections of project-related resources. CoVis' rich and well-organized site at <http://www.covis.nwu.edu/> offers a plethora of materials that participants can use as they explore geosciences in telementoring contexts, "learning through collaborative visualization." The architects of the CoVis page have clearly shown that the key to making project support sites maximally useful is to organize the materials for quick and efficient access.

7. Project Chronology

Web sites can present chronologies of past and ongoing project work. For example, at GlobaLearn <http://www.globalearn.org/>, visitors can view rich artifacts that trace the experiences of a group of students who travelled for eight weeks around the Black Sea, beginning and ending in Istanbul. In taking this trip and communicating with students as they did so, the "expedition team" provided "tele-field-trip" opportunities for 5000 other students from all over the world. Other expeditions have since begun, and are similarly chronicled at this site.

8. Showcase of Participants' Works

Web sites can provide viewing space for sharing project participants' creations. For example, MidLink Magazine at <http://longwood.cs.ucf.edu/~MidLink/> is an electronic publishing project for "kids in the middle grades." It publishes students' art and writing four times each year. Each issue of this "e-zine" is a thematically linked collection of students' works that are associated with different educational telecomputing projects.

9. Project Centre

Web sites can serve as multipurpose centres, combining several of the project-related functions listed above. For example, the Global SchoolNet's KidsPeak tele-field-trip project <http://www.gsn.org/gsn/proj/everest/> which followed mountain climber Sandy Hill Pittman as she and her team ascended Mount Everest in 1996, creates an information-rich, facilitative, multipurpose "virtual centre" for an educational telecomputing project.

10. Project-Spawning Service

There are a growing number of services that help teachers and students locate information and make interpersonal contacts. For example, the Intercultural E-Mail
Classroom Connections service <http://www.stolaf.edu/network/iecc/> is a keypal and global classroom partner locator.

11. Collaborative Projects

The World Wide Web is a wonderful resource for collaborative learning. It allows highly motivating participation in real-life projects from all over the world. Collaborative projects allow teachers to become guides rather than "experts." Individual work and team learning is enhanced through sharing. Project work becomes meaningful as students come to rely on a wide range of resources and contacts. Shared experiences, collaborative building of data and material or mutual understanding all are made possible by the World Wide Web.

At the Collaborative Learning Projects strand <http://www.2learn.ca/Projects/clp.html>, teachers can get the "big picture" on projects. This site is part of the TELUS Learning Connection: An Educational Internet Alliance initiative, which is designed to initiate and support collaborative projects that integrate core curriculum and technology. For more information about the TELUS Learning Connection, go to <www.2learn.ca>.

The Globe Project <http://globe.fsl.noaa.gov/welcome.html> also contains instructional resources. Students and teachers from over 3000 schools in thirty-nine countries are working with research scientists to learn more about our planet.

Finally, the School Museum List and Site <http://fromnowon.org/museum/oldies%26000dies.html> lists resources on building school museums.
CREATING A WEB SITE: THINGS TO CONSIDER

CONTENT, DESIGN AND DEVELOPMENT

Here are some guidelines for creating school home pages.

1. Ownership

The most crucial question in web site development is "Who will take ownership of the web site?" You may consider establishing a team or committee to take responsibility for creating and maintaining your school web site. Everyone needs to know who the contact person is and who is ultimately responsible for maintaining a schedule and ensuring the site is updated regularly. It is important to keep the page current and to have a schedule for development and implementation.

2. Content

Provide content that has value to others in your school and in your community. Try to involve as many people from the school community as possible so there is a sense of community ownership. Make every page count. Consider the high cost of following each and every link. For safety's sake, be careful about including information on students.

A school web site can include the following types of information and requests for feedback.

Information about the school:
- general description, including location, grade levels, number of students and teachers,
- message from the principal,
- school philosophy, mission and goals,
- description of unique features of programs or courses, and
- photographs.

Student activities:
- description (e.g., sports, clubs, music groups),
- meeting times,
- requirements,
- try-out information,
- schedule of events (e.g., sports schedules, school plays), and
- name of advisor.

Classroom projects:
- lesson plans,
• description of use of Internet in a particular class,
• student art work (drawing, painting, photography),
• student writing (poetry, essays, short stories), and
• annotated list of links in a subject area.

Publications:
• school newspaper,
• literary magazine,
• course catalogue,
• list of college enrolments,
• summer reading list,
• list of students on honour role, and
• student home pages.

Unique information collection:
• history of town or special place near the school,
• collection of memorabilia (from local museum or historical society),
• information about a special natural area or habitat, and
• in-depth information on any unique topic (Search the Web to be sure the topic is novel.).

To view examples of Alberta school web sites, click on the "WWW School Sites in Alberta" link in the technology section at <http://ednet.edc.gov.ab.ca/technology>.

3. Scope

Start small. It is better to publish a few excellent pages than a large quantity of partially complete pages. Gradually add material. It is great to have a plan for future expansion, but remember that every page you publish will need to be maintained.

4. Audience

Define one or more specific audiences for your site and create material that is specifically targeted to these audiences. For example:
• students in your school or world-wide,
• teachers and administrators in your school or world-wide,
• parents in your school or world-wide,
• interested educators, and/or
• a specific special-interest group.
5. Links

Avoid creating a page that has only links. Annotate links to give a clear idea about what is at the other end. Structure the material so visitors do not have to follow too many links to get to the "meat." Include navigational links on every page. At the very least, there should be a link to the home page on every other page. Make sure that all links work.

6. Graphic Design

Repeat design elements. Use a common background and a common set of page layouts. Do not use busy backgrounds. Even if the text shows up clearly on the background, it can be difficult for people to read if there is too much "noise." Plain white is always a safe choice.

Keep in mind the time it takes to transfer images. Use "thumbnails" (miniature versions of images) if you have a need for many images on a single page. Visitors can click on these images to see the full-sized versions.

Use student artwork to illustrate your pages, or ask local graphic artists if they will donate illustrations.

In designing a page, try to maximize legibility, impact, feedback, responsiveness and orientation under a wide variety of viewing conditions. Try to use different areas of the page to serve different functions. Consider what happens if the user expands the window or has a bigger monitor. For more details, see "Effective Page Design," in this report.

7. Form Versus Function

Judi Harris of the Department of Curriculum and Instruction at the University of Texas notes that current web design is primarily addressed in terms of form and content, not function. The focus is usually on:

- layout options (i.e., "Should we use frames?")
- overall structure (i.e., "One long page with links to subsections or multiple, shorter pages?")
- transfer time (i.e., "How many graphics should I put on this page?")
- browser differences (i.e., "Will Lynx users be able to benefit from my site?")
- readability (i.e., "Does this combination of background pattern and text colour make the page difficult to decipher?")
- aesthetics (i.e., "Is the combination of colours, items and spacing pleasing to the eye?")

Dr. Harris suggests considering project-related functions when designing WWW documents.
8. Updates

Try to design your site with expansion in mind. Create a naming scheme for pages and an organization system that will be easy to scale up. Do not publish pages before they are ready. Wait until a page has enough content to be of value to a visitor before adding it. (Do not say a page is under construction. The general assumption is that all sites are under construction.)

9. Testing

Thoroughly test all the links. Try out your pages in different font sizes. Your pages should work with different browsers; e.g., Netscape Navigator and Internet Explorer. The web page should download in a reasonable amount of time. It is important that your web page works on low-end systems. The ease of navigation also should be considered.

10. Security

Web server security issues include:
- authentication: Users must supply a valid user name and password, and
- transmission security: Transmissions between two computers or systems can not be intercepted.

11. Sensitive Issues

Web site developers also need to be sensitive to and respectful of individual, family, community and cultural values.

COPYRIGHT AND OTHER LEGAL RESPONSIBILITIES

When developing a web document, consider the legal issues associated with web publishing. These include copyright, the Freedom of Information and Protection of Privacy (FOIPP) legislation and libelous or slanderous content.

COPYRIGHT

For information regarding copyright in Canada, visit the following sites:
- Information on copyright reform in Canada, a copy of the current Canadian Copyright Act and Bill C-32
  <www.pch-inet.qc.ca>
- Information on the books Canadian Copyright Law, Digital Property: Currency of the 21st Century and The Copyright & New Media Law Newsletter: For Librarians & Information Specialists
  <http://copyrightlaws.com>
- Information on Canadian copyright law, an interactive Frequently Asked Questions (FAQs) section and discussion on Bill C-32
  <http://www.mcgrawhill.ca/copyrightlaws>
WHAT IS COPYRIGHT?

Copyright protection in Canada is an exclusively federal jurisdiction as set out in the Copyright Act <http://canada.justice.gc.ca/STABLE/EN/Laws/Chap/C/C-42.html>. Under this Act, the person who owns the copyright, often the creator of the work, has the right to decide when and how the work is copied. Copyright protects the form of expression of a work. It does not protect the idea or content of the work. Copyright does not prevent someone from taking and using an idea from someone else's work. The purpose of the Copyright Act is to protect the rights of creators to be paid for, and to control the use of, their work and to address the needs of users who want to access material that is protected by copyright. A copyright—"the right to copy"—means that an owner is the only person who may copy his or her work or permit someone else to do so. Generally, copyright in Canada lasts for the life of the author and for fifty years following the author's death ("life-plus-fifty").

The current Canadian Copyright Act, which was originally passed in 1924, has been amended a number of times. For example, in 1988 Bill C-60 amended the Act to address collectives (e.g., CANCOPY) and in 1997, Bill C-32 amended the Act again to provide exceptions for certain user groups including educational institutions and libraries.

Copyright is automatically granted in Canada whenever an original work is created. Modern technology has made it easy to reproduce many kinds of work that are subject to copyright. Great care must be taken to avoid infringing on the rights of others by copying their work. Penalties for violating copyright can be very costly.

The Canadian Intellectual Property Office website, located at <http://strateois.ic.gc.ca/sc_mrksv/cipo/help/faq_cp-e.html>, provides answers to frequently asked questions with respect to the issue of copyright.

WHAT DOES COPYRIGHT APPLY TO?

Copyright applies to all original literary, dramatic, musical and artistic works. These include books, maps, lyrics, musical scores, sculptures, paintings, photographs, films, plays, television and radio programs, CD-ROMs, web pages, computer programs and databases, and other electronic representations. Copyright also applies to sound recordings such as records, cassettes, and tapes. The owner has the sole right to control any publication, production, reproduction and performance of a work or its translation. Royalty payments may be arranged through performing rights societies, collectives, publishing houses, or by the owners directly through contracts. Themes, ideas, most titles, names, catch phrases and other short-word combinations of no real substance are not protected by copyright. Also, copyright does not apply to original ideas, information, facts, history or news events.

WHO OWNS THE COPYRIGHT?

Generally, the owner of the copyright is:

- the creator of the work,
the employer, if the work was created in the course of employment unless there is an agreement to the contrary,

the person who commissions a photograph, portrait, engraving or print for valuable consideration unless there is an agreement to the contrary, and

some other party, if the original owner has transferred his or her rights.

It is important for educators to remember that work created in the course of employment belongs to the employer. A web page made for the school belongs to the school jurisdiction. Works created by a freelancer or consultant belongs to the author/creator. Commissioned work belongs to the person ordering the work unless there is an agreement stating otherwise.

As stated previously, copyright is automatically granted in Canada whenever an original work is created as a result of which you are automatically protected by law. There are two other actions that can be taken to reinforce your interest in copyright protection:

- mark all work of interest with a small © in a circle (a widely acknowledged indicator of copyright protection), the name of the copyright owner and the year of first publication. This visual expression of copyright interest may not only serve to discourage unauthorized copying, it may provide copyright protection in some other countries, and

- register a copyright with the Federal Government's Copyright Office.

HOW CAN TEACHERS LEGALLY USE MATERIAL PROTECTED BY COPYRIGHT?

CANCOPY <http://www.cancopy.ca> is a non-profit organization founded by Canadian writers and publishers. It is a collective organization that administers the legal rights of copyright owners. Alberta Education has signed a licence with CANCOPY that allows schools to legally copy a wide variety of published material without violating the law. All public schools in Alberta are covered by CANCOPY through a small fee per full time equivalent student. This fee is deducted from the basic instructional grant. CANCOPY allows schools to copy up to ten per cent of a book or a chapter from a book (whichever is greater): an entire story, essay, article, poem or item of music from a book or periodical; an entire newspaper article or page; an entire entry from a reference work or an entire reproduction of an artistic work from a book (prints, photograph). However, the CANCOPY agreement does not allow schools to copy unpublished works, teacher guides and manuals, Government of Alberta publications, published workbooks, tests, and other consumables, print music, original artistic works, including photographs and prints, negatives or other transparencies, or works that are on the CANCOPY’s exclusions list.

It is important to remember that in Canada the focus of the Canadian Copyright Act is on activities that infringe copyright. This is to be contrasted with the copyright statute in the United States which has tended to identify specific classes or categories of persons who are deemed to be either infringing or exempted in certain circumstances. In the United States, educators have what is called "fair use" while in Canada it is "fair dealings." To invoke this provision, the "dealing" must be for one of the specified purposes and must be "fair." The specified purposes include: private study, research, use in a critique or review and use in a newspaper summary. Private study does not encompass classroom handouts, or any scheme of requiring students to make their own individual copies of a
portion of a work for classroom purposes. For example, it would not be fair dealings to scan an article and post it to a web site for students to access without written consent of the author. Copyright infringement is the unauthorized use of copyright material. Plagiarism, the passing off of someone else's work as your own, is a form of infringement.

Posting materials on the Internet or on a web site is, technically, reproduction and, therefore, would be considered an infringement of copyright. Permission to do this must be obtained. Printing material off the web also is reproduction and, again, permission to do so is required.

The owner of the copyright work may licence (give temporary permission) or assign (give permanent permission) to others to use or own that copyright work. There may be a fee charged for the use of a copyright work. This must be negotiated between the copyright owner and the user of the right. It is important to have written permission in order to cover liability since copyright exists on works for a period of life-plus-fifty. Once a copyright expires, the work is in the public domain and can be used without permission or the paying of a fee. Items such as text, images and music (in digital format) that are in the public domain can be used freely.

The responsibility for policing your copyright rests with you. Educational institutions cannot make multiple copies of parts of books or articles for student use. The making of multiple copies requires the consent of the copyright owner. This consent may be obtained through a licensing agreement with a photocopying collective. However, the Copyright Act does allow the copying by individuals of parts of works for private study or research. Such copying should be minimal. This exception falls within the "fair dealings" section of the Act.

The best practice is to determine if there is an exception in the Act that permits the use of a particular work. If there is no exception, then determine if it is covered by a general licence from a collective such as CANCOPY. If a general licence is not signed, contact the owner for permission. Remember that students, as creators of work, have copyrights. Teachers must obtain permission to copy a student's work.

Schools are not liable for teachers who infringe copyright.

WebWhacker is a software product that captures web pages and allows you to save them to the hard drive of your computer or to a jurisdiction file server. Many jurisdictions are using WebWhacker to create "intranets" that allow students and staff to enjoy Web experiences without leaving the local network. Collecting web pages locally results in much faster access than real Internet access and it allows jurisdictions to focus student exploration on pages and sites that meet curriculum standards and goals. However, before downloading any pages from a site, the jurisdiction should obtain explicit, written permission. Despite what some software companies may tell you, those pages belong to the owner of the web site, and wholesale copying and republication on a WAN is illegal.

Many schools have purchased clip art collections to use with students. The licensing agreement included with the software defines how the product can be used. In most cases, the agreement is printed on some kind of seal that is broken upon opening. Review the agreement or check with the company that produced the clip art images.
Read the small print. Do not assume that you have the right to use these images wherever you want.

Unless there is a clear statement that art, photos and text are in the "public domain" and available for free use, assume that they are copyrighted. These items should not be published on a LAN, a WAN or a web site. Internet pirates argue that work is not copyrighted unless there is a clear notice on the web page or site, but this simply is not the case. Copyright law protects work even if no papers have been filed. Most people agree that students may use these items for educational purposes but companies can be extremely aggressive about protecting their icons and logos. Before copying, make sure permission has been granted; and provide a credit line near the item or at the bottom of the page.

Student work is not only covered under the Freedom of Information and Protection of Privacy Act but also deserves protection against piracy. Many school jurisdictions post copyright notices on the bottom of all pages. Most schools are careful not to publish the full names of students. If someone asks to publish work, it is best to forward the request to the family. Jurisdictions often have policies on the publication of student work.

Finally, there should be a clear statement explaining procedures for use of the jurisdiction's documents.

FREEDOM OF INFORMATION AND PROTECTION OF PRIVACY

Alberta's Freedom of Information and Protection of Privacy Act (FOIPP) is based on five fundamental principles:

1. to allow a right of access to any person to the records in the custody or control of a public body, subject only to limited and specific exceptions,
2. to control the manner in which a public body may collect personal information from individual Albertans, to control the use that a public body may make of that information and to control the disclosure by a public body of that information,
3. to allow individuals, subject to limited and specific expectations, the right to have access to information about themselves which is held by a public body,
4. to allow individuals the right to request corrections to information about themselves held by a public body, and
5. to provide an independent review of decisions made by a public body under the legislation.

This legislation applies to all records in the custody or control of a public body. "Record" means a record of information in any form, including books, documents, maps, drawings, photographs, letters, vouchers and papers, and any other information that is written, photographed, recorded or stored in any manner, but does not include software or any mechanism that produces records.

The FOIPP Act states that a public body can not collect personal information from any individual without the permission of that person. Public bodies also have a duty to ensure that reasonable security arrangements are maintained for personal information in their possession. Any personal information it collects from individuals can be used only for the
purpose for which it was obtained. Schools need to consider the implications of FOIPP when collecting or posting a "record" to a web site. Permission has to be obtained before any record can be collected or used.

For more information about FOIPP, visit the following locations:

- Alberta Freedom of Information and Protection of Privacy Home Page
  <http://www.gov.ab.ca/foip/index.html>
- Review of Freedom of Information and Privacy
  <http://www.assembly.ab.ca/FOIP/intro/intro.htm>

THE SCHOOL'S LEGAL RESPONSIBILITIES

In many schools, the web site emerges as a computer club project, and the group proceeds without knowledge of copyright and FOIPP issues. In each school, a designated staff member should be responsible and accountable for any material that is posted to the school's web site. Jurisdictional standards or policies also are recommended. For further information on the FOIPP Act and how it relates to schools, please refer to the following best practices documents:

- FOIPP and Technology: Best Practices for Alberta School Jurisdictions, and

Schools must always be on the watch to avoid slanderous materials. Libel and slander in school newspapers or web sites are grounds for legal damages. In web publishing, the damages resulting from malicious publishing may far exceed those formerly associated with school newspapers.

Schools also are responsible for reviewing content to ensure that it conforms to community values. The courts have ruled that schools have the right to limit freedom of expression in publications in cases where that expression might conflict with community values. Jurisdictions need to create procedures for all publications, including web publications.
PLANNING A WEB SITE

When planning a web site, consider the following questions:

1. What are your objectives/goals?
2. Who is the intended audience?
3. What is the message?
4. Are the objectives realistic?
5. What would be considered success? Failure?
6. How will you measure success?
7. How does the web site fit into your marketing strategies?
8. Who has the expertise to develop the site?
9. Is administration/management involved?
10. Do you need to establish a team?
11. Who has the expertise and resources to maintain the site?
12. What is the budget for hosting the site? Updates? Other?
13. Do you have the technology to host your own site or will you pay a service to host the site?
14. Does your organization have publishing guidelines? If so, are your ideas consistent with these guidelines?

Remember to keep the plan simple. Begin by brainstorming. Mindmaps or outlines can be helpful. The organization of the web site flows naturally from the defined purpose and audience.

Your objectives may be curricular or related to communications and marketing, or a combination of these.

Possible curricular uses:
- to direct student use of the Internet and provide quality sites that demonstrate curriculum connections,
- to share local or community data with others in the world, and
- for students to demonstrate their learning.

Possible communications and marketing uses:
- to provide current and useful information about the school and to promote school events, such as open house evenings and demonstrations of learning or extracurricular activities, and
- to introduce visitors to the school (school mission and vision, curricular and extracurricular programs, FAQs, etc.).
The following chart illustrates how a school or school jurisdiction might plan to assess its progress in meeting objectives and assign responsibilities in that regard.

<table>
<thead>
<tr>
<th>Objective</th>
<th>Measurable Goal</th>
<th>Responsibility/When?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curricular—to provide an interactive learning environment for students</td>
<td>Each teacher creates links to curriculum-related sites for one unit of study.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Classes have an opportunity to showcase student work in the &quot;Publications&quot; gallery; e.g., virtual field trips or survey results.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Classes create forms for collecting data or announcing on-line curriculum-based projects.</td>
<td></td>
</tr>
<tr>
<td>Communications—to provide current information about school events</td>
<td>The web site lists extracurricular activities and tournaments in the &quot;Student Activities&quot; section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open house and &quot;demonstration of learning&quot; announcements are included in the &quot;What's New?&quot; section.</td>
<td></td>
</tr>
<tr>
<td>Marketing—to introduce a selected audience to the school and available opportunities</td>
<td>The school mission statement, information about special programs and an e-mail address to write to for more information are included in the &quot;School Information&quot; section.</td>
<td></td>
</tr>
</tbody>
</table>

As you develop your site it is important to consider the various options or connections that you will make from the main index page. One suggestion is to use a site map. Site maps can be created using software such as Inspiration or flow charting/organizational software such as Powerpoint. The purpose of the site map is to visually convey simple relationships between the various web pages and the main index. An example of this is shown in Figure 1.
FIGURE 1: CONCEPTUALIZING A SCHOOL WEB SITE

Content

Curricular Content
Examples of content...
- Classroom projects
- Samples of student work
- Course outlines
- Course evaluations

Administration
Examples of content...
- School operations
- Contact information
- Attendance processes
- Mission statement

Processes
Examples of processes...
- Site search
- E-mail feedback form
- On-line registration
- Request for information forms

More ideas...
- Student services
- Library information
- Complementary course information
- Work experience
- On-line projects

More ideas...
- Technology plan
- Bussing
- School Council
- Notices of field trips, holidays, sports events
- Volunteer information
- Notices of parent-teacher interviews
- School trustees contact
- Staff information
- Health services
- Provincial achievement test reports
EFFECTIVE PAGE DESIGN

When designing a web page, you need to understand how all the parts come together. Consider the content, the art and the technology.

White space is important. Bigger, brighter, bolder are not always better.

Consider the various computer platforms that will access your page. Will the page fit on various screen sizes?

Make pages accessible. The pages you create must load within a reasonable amount of time.

Designers indicate that you should have only one page per screen. Although people can use the arrow keys to scroll up, down, left and right, research has shown that people read just what is on the current screen. To avoid using a horizontal scroll bar, make 600 pixels the absolute width of any given total graphic or table.

Consistency in the pages and buttons within your site helps your audience easily navigate through the content. Design your page so that the message is consistent. Consistency in text options and navigational elements should always be considered.

Consider designing a template or common layout for all of your site pages that includes the following elements:

- jurisdiction logo with link returning to jurisdiction web page,
- school logo,
- name, address, phone, fax, webmaster’s e-mail,
- copyright message (1999 © name of school),
- link to index page, and
- revised date or current date (stamp).

Consider adding your school logo to the header with a link to your index page. Include a title in the header section of your document. Keep the size and style consistent throughout.

If your document is lengthy, consider section links to provide quick access to the areas on the page. The section links are like a table of contents with hyperlinks to quickly move to the selected section in the document.

The footer is an excellent place to include a copyright message, author’s name and an e-mail link to the webmaster, a link to the index page and the date the page was created or revised. A school or jurisdiction logo could be included on the footer of each page instead of in a header. Here are the items you might want to include in the footer:

- copyright message (1999 © name of school),
- author’s name (first initial followed by last name),
Text or **font** faces should be easy to read. There are two major font families, serif and sans serif. Serif fonts have horizontal strokes on the letters that create a horizontal band on a page. Courier is an example of a serif font while Helvetica is a sans serif font. Researchers have discovered that serif fonts are the preferred choice because the horizontal strokes make it easier to locate your place on a page of text. Sans serif fonts are thought to be good for headers and short bursts of text because they are easier to recognize. Remember that font colours should enhance the text and make it easier to read. Avoid too-thin fonts or very elaborate scripts. Titles, subtitles and body copy should be of a consistent size and style. Underlining is used on the World Wide Web for hyperlinks, so use bold or italics to emphasize copy.

**Note:** Do not use the tab key or space bar to indent or move text to different locations. Internet browsers do not interpret tabs or consecutive spacing properly. Use tables to place text in different areas of the page or to wrap around graphics.

**Lists** may be used to organize sections of your web page or to emphasize important points. Use the same bullet or numbering convention throughout the page for consistency. Check out the Web Review Style Sheets Reference Guide at <http://style.webreview.com>.

Background **colour** is another item to consider. Your school colours can be used, but remember that a white background is recommended for readability.

**Graphics** enhance a web page. Each jurisdiction or school index page should contain the appropriate corporate logo. Consult with your school jurisdiction about policies, standards or guidelines on the use of the logo; for example, placement, size, colour and appropriate format.

Choose graphics that directly relate to the content on the page. Keep the graphics to a minimum to avoid long download periods for slower Internet connections and older browsers. The placement of graphics on a web page can become a frustrating task. Place graphics in a table to allow easy placement and modification. Try to establish consistency in the placement and use of graphics throughout your web site. As with any web graphic, try to optimize by reducing the colours, index and drop bit number, until you have a small, quality graphic. Be sure that any words can be easily read.

Graphics on the World Wide Web are commonly in GIF or JPEG formats. If you scan or create graphics in different formats, you may need to convert them before inserting them in your web page.

Many web sites include **sound and video**, but since many users will not appreciate error messages when they are missing a required plugin or player, be sure to include links to
sites where your audience can download the appropriate programs. You may decide to include sound and video clips only on your local intranet instead of for global access.

**Frames** should be used only if they will improve access to your site pages. Since browsers are unable to load frames, it is necessary to provide a "no-frames" version as well. View examples of pages with frames and determine whether they are an essential element for your site.

And finally, include your web site address in your e-mail signature so everyone will visit your page.
INTRANETS AND WEB SERVERS

Many schools and jurisdictions are considering using intranets and web servers to host their web sites.

An **intranet** is a private network set up for exclusive use by a school or school jurisdiction so that information and communication can be shared using a web browser. These networks are primarily used internally. Intranets allow a school to publish information, provide access to electronic mail, conduct virtual meetings, access centralized databases and broadcast the latest news to all computers at the same time.

These sites provide more information on intranets:
- Microsoft Guide to Intranets Web Site
  <www.microsoft.com/intranet>
- Netscape Intranet Solutions
  <home.netscape.com.comprod/at_work/index.html>
- Intranet Design Magazine
  <www.innergy.com>
- Intranut
  <www.intranut.com>
- The Complete Intranet Resource
  <www.intrack.com>
- The Intranet Journal (SM)
  <www.intranetjournal.com>

The **web server** is the cornerstone of your web site because the server you choose can have a dramatic effect on the content you provide. Since a server is a central repository for shared files and applications, it usually accommodates somewhere between ten and 100 times as much storage as a workstation.

Web servers serve documents over HTTP, using the TCP/IP protocol suite. Information on HTTP and the TCP/IP protocol suite can be obtained at <http://www.w3.org/protocols>.

A network is only as fast and reliable as its bandwidth and servers. Servers need to be deployed to support the activities and traffic levels on your network today, with sufficient capability in reserve to handle growth and expansion in the near future. This means close attention should be given to a server's components and the application it is meant to perform.

Different servers provide different functionality. Servers are bigger, more powerful desktop computers. Along with raw processing speed, a server must include high-speed drive controllers, storage devices and network interfaces. Each of these devices can cause a performance bottleneck—not only if it is slower than the machine's bus, but also if it is not matched with the abilities of the overall system. Characteristics such as bus mastering, direct memory access, buffers and other design techniques to improve adapter speeds are far more important on servers than they are on ordinary desktop computers.
A workstation needs only enough hard disk capacity to contain its operating system, some applications and a limited amount of private data. When a file server is configured, calculate how much disk space each user on the network will require and multiply that by the projected number of users. For an internet web server, plan for the total number of documents that your organization releases for public consumption.

In general, servers need to have a fast central processing unit (CPU). Web servers, however, are more input/output (I/O) intensive than CPU intensive. CPU is important, but fast disk access and lots of random access memory (RAM) is more important than the latest CPU.

Fault tolerance is a server's ability to continue running when things go wrong. A server must be able to sustain continuous, high levels of utilization even in the face of component failures, power problems, ill-behaved applications and careless users. Most servers include a number of features specifically designed to improve reliability.

Low- to medium-range servers should always include high-quality, high-mean-time-between-failures (MTBF) power supplies. But medium- to high-range servers are invariably built around redundant power supplies, so that a single power-supply failure will not bring down the house. The best include hot-swappable power supplies, so that a replacement for a failed unit can be installed without powering down the machine.

Hard drive disk "arrays"—known as redundant array of inexpensive drives (RAID)—work together to compensate for the loss of a single drive, continuing to permit data access (though with some reduction in performance). More capable arrays enable you to swap drives on the fly, without shutting down. High-end disk arrays often support multiple disk controllers, too, so that a single controller failure will slow down—but not sideline—the entire array.

Many servers include special adapter cards that monitor the server in real time. These devices communicate with management consoles to report on a server's internal operating temperature, provide status information about system components and report not only when outright errors or failures occur but also issue alerts when boundary conditions indicate impending problems or failures. A classic example: when a disk drive or array reaches ninety per cent of its total capacity, an alert is triggered. When considering a web server, consider speed, storage and security.

Internet servers come in many varieties, from web servers that serve tens of thousands of pages an hour to small intranet servers designed to support a workgroup. Internet servers must withstand large numbers of simultaneous service requests, from 1,000 to 100,000 per second. That means they must be optimized for high network utilization and the fastest possible response. Since servers capable of supporting this level of activity demand high-speed network connections, they frequently use multiple CPUs, with at least 128 MB of RAM per CPU.

The key to configuring a server of this type is to offset the potential bottlenecks. One or more high-speed network connections will help avoid swamping the inbound and outbound network traffic. Fast CPUs ensure that large numbers of execution threads can be active and rapidly handled at any given moment, and that large amounts of RAM help
ensure sufficient working space to accommodate the aggregate needs of large numbers of active threads and processes.

Selecting a server for purchase need not be difficult. There are four significant factors to consider.

1. Budget

2. Platform preference

Traditionally, UNIX was the operating system of choice, running on UNIX-specific hardware (a UNIX platform). More recently, however, PowerPC-based Macintoshes and Pentium-powered Windows platforms are becoming increasingly affordable and powerful. Decide what computer platform is preferred and consider prior experience with specific operating systems and hardware types. Ask if the network operating system or networked applications require a particular platform. Due to hidden costs associated with the learning curve, purchasing an unfamiliar platform normally represents poor use of resources.

Since most servers must be attached to an existing network, you may need or want to use the same network operating system across all platforms. The conventional wisdom is that changing platforms is warranted only when a must-have application dictates such a change, or when sufficient performance simply is not available from what is already in use.

3. The level of traffic

If your network spans an enterprise with over 10,000 users or more than 200 to 300 servers, you will need a much more powerful and expensive server than you would for a small- to medium-sized operation (under 1,000 users and less than 100 servers). At the very highest levels of demand, it may be necessary to cluster multiple servers or to distribute the load across multiple individual servers.

4. Needs

Web Weaving: Designing and Managing An Effective Web Site by Eric Tilton, Carol Steadman and Tyler Jones is an excellent reference on evaluating web servers.
CONCLUSION

As more Alberta schools and school jurisdictions access the World Wide Web, more web sites are being built for educational purposes. Web development means more than putting up a site; it means maintaining the site so that it will constantly inform, communicate and serve various audiences.

To make your web site work:

1. consider the jurisdiction's standards for web sites and the goals you hope to achieve, and
2. keep current by reviewing new resources on web development, including Alberta Education's "best practices" reports on network design and Freedom of Information and Protection of Privacy (see Appendix C).
WEB SITE DEVELOPMENT RESOURCES

ON-LINE RESOURCES

The easiest way to get information on the “net” is to use Hypertext Markup Language (HTML). One of the original design goals of HTML was to be device independent, that is, usable on a variety of computer systems without change. It was designed to be a language to describe document structure rather than document presentation. Basic HTML elements specify such things as headings, titles and paragraphs, but not margins and fonts. The browser on a specific system renders the document in whatever way the browser’s author thinks is most suitable.

**HTML resources:**

- NCSA Beginner’s Guide to HTML
  <http://www.acsu.buffalo.edu/NCSA/WWW/HTMLPrimer.html>
  The classic guide to learning HTML.

- HTML Crash Course for Educators
  <http://edweb.cnidr.org/htmlintro.html>
  Complete with interactive quizzes.

- The Essential World Wide Web Site Design Guide
  <http://edweb.cnidr.org/htmlintro.html>
  An overview of layout and presentation specifics for the Web.

- The Web Developer’s Virtual Library
  <http://www.stars.com/>

- Introduction to HTML
  <http://wdvl.internet.com/Authoring/HTML/Intro/>
  A quick introduction, with many links to further information.

**JavaScript** is a compact, object-based scripting language for developing client and server Internet applications. JavaScript statements can be embedded directly in an HTML page and can recognize and respond to user events such as mouse clicks, form input and page navigation. For example, you can write a JavaScript function to verify that users enter valid information into a form. Without any network transmission, an HTML page with embedded JavaScript can interpret the entered text and alert the user with a message if the input is invalid. Or you can use JavaScript to perform an action (such as play an audio file, execute an applet or communicate with a plug-in) in response to the user’s opening or exiting a page.

For more information on **JavaScript** try these resources:

- Authoring JavaScript
  <http://wdvl.internet.com/Authoring/JavaScript/>

- Simple JavaScript Scripts by Reaz Hoque
  Neat little scripts that you can use in your home pages.

- JavaScript Tutorials
The Largest Java Script Repository on the World Wide Web
<http://www.htmlgoodies.com/javagoodies/>

These on-line resources provide information on web development:
- Jamie McKenzie
  <http://www.fromnowon.org/>
- TELUS Learning Connection
  <www.2learn.ca>
- <http://webstuffforfree.com>
- <http://iconbazaar.com>
- The Site Builder Network
  <http://www.microsoft.com/sitebuilder>
  A multilevel program for web designers.
- University of Alberta Web Site Construction Site
- Guide to Web Style
  <http://www.sun.com/styleguide/>

Also, get free tools and technical information by adding the Internet Explorer logo to your web site.

These graphic resources will help you to enhance your web site:
- Bells n Whistles
  <http://www.bellsnwhistles.com/>
  Animations and graphics for your web site.
- Clip Art
  <http://www.microsoft.com/clipgallylive>
  Download and easily install in the Microsoft Office clip art file.
- Clip Art Connection
  <http://www.clipartconnection.com>
  Free clip art, with copyright information.
- Clip Art Directory
  <http://www.clipart.com>
  Alphabetical list of clip art sites.
- Icon Bazaar
  <http://www.iconbazaar.com/>
  Limited educational use of up to twenty images from the archives. Link back to icon bazaar page and copyright notice wherever appropriate.
- Icons, Banners
  <http://www.flash.net/~lorewicons.html>
  HTML help links (counter and other page enhancements).
To announce your presence on the World Wide Web, try these site promotion and advertising resources:
• World Wide Web Virtual Library
  <http://www.w3.org/hypertext/DataSources/bySubject?Overview.html>
  Individuals volunteer to maintain a subject index. Get your web site added to the subject list.

• Publicizing Your Web Site
  <http://www.goldray.com/register.html>

• Web Step Top 100
  <http://www.mmgco.com/4-star.html>
  Allows you to submit your page to search engine databases.

COMMERCIAL RESOURCES

• Microsoft Frontpage 97
  <www.microsoft.com/frontpage>.
  Wizards you can automatically use to create your page or site.

• PageMill, Version 2.0
  <http://www.adobe.com/prodindex/pagemill/overview.html>
  Fifteen-day trial period.

• Claris HomePage, Version 3.0
  Free beta available. Thirty-day trial. Tips and tricks, resources, training and FAQs.

• AOLpress
  Free web page software available for Macintosh and PC platforms. Easy to use. Supports frames.
REFERENCES


GLOSSARY OF TERMS

Applet
A program designed to be executed from within another application. Applets are commonly used in Internet applications. Unlike an application, applets cannot be executed directly from the operating system.

Authentication
Providing a password or using an encryption key to prove you are who you say you are.

Baud Rate
Rate at which packets of data are sent and received through the network. These rates are defined in terms of bits per second (bps). Speeds vary from 14,400 bps (quite slow) to 56,000 bps (56K leased line—faster) to 1,500,000 bps (T1—very fast). Networks that form the backbone of the Internet often use T3 lines, which are capable of transmitting 45,000,000 bps. The higher the baud rate, the faster the connection.

Bandwidth
The amount of data that can be transmitted in a fixed amount of time. For digital devices, the bandwidth is usually expressed in bits per second (bps) or bytes per second. For analog devices, the bandwidth is expressed in cycles per second, or Hertz (Hz).

Browser
Software that allows you to view the World Wide Web. The most commonly used browsers are Netscape Navigator and Internet Explorer. Text browsers such as Lynx and MacWWW do not display graphics and are used by people with slow connections and/or text-only terminals.

Buffer
An intermediate (and usually temporary) data storage or holding area. Typically, buffers are used to increase the speed or efficiency of data transfer. For example, when a computer sends information to a printer, the information is usually sent to a print buffer first. The print buffer then releases the information to the printer. In so doing, the computer is freed to perform other tasks while printing is taking place.

Clip Art
Electronic illustrations that can be readily inserted into a variety of documents.

CPU
An acronym for Central Processing Unit. The CPU is the computer analogue of the human brain. It is one of the defining characteristics of a computer's architecture.

Default
A value or setting that will be automatically used if a substitute is not specified. For example, when creating a word processing document, an author typically defines parameters such as margins, indents, font type and size, etc. In the event that the author does not define these parameters, already-established values will be used. Newly established settings often are remembered and become the current default.

E-zine
An electronic magazine or journal.

Frames
A feature supported by most modern web browsers that enables the web author to divide the browser display area into two or more sections (frames). The content of each frame is taken from a different web page. Frames provide great flexibility in designing web pages, but many designers avoid them because they are supported unevenly by current browsers.
**GIF**
An acronym for *Graphics Interchange Format*. The industry standard for graphics on the Web. GIF files support 8-bit or 256-bit colours and are best used for illustrations or flat graphics.

**Home Page**
The first page of a web site, which commonly acts as a menu to other pages.

**Hot Spot**
A "live" area in a document. Selecting a hot spot causes a predefined course of action to take place. Hot spots, which can vary greatly in size, are generally selected by clicking on them. Hot spots are particularly common in multimedia applications, where clicking on one can make the application display a picture, run a video, or open a new window of information. The "hyperlink" is rapidly becoming the most significant type of hot spot. Hyperlinks take the user to another place in the same document or to an entirely different document. They are commonly used on Internet applications and the World Wide Web in particular.

**HTML**
An acronym for *Hypertext Mark-up Language*. The language used to develop web pages. Browsers interpret HTML documents and display the text and graphics represented in the code.

**HTTP**
An acronym for *Hypertext Transfer Protocol*. The means of communication between the web browser and the web server. When a web browser requests an HTML document from a web server, the connection is opened, the document transferred and the connection closed.

**Hyperlink**
An element in an electronic document that links either to another place in the same document or to an entirely different document. A hyperlink is a type of "hot spot." Typically, clicking on a hyperlink hot spot initiates a voyage of discovery through one or more related documents. Hyperlinks are the most essential ingredient of all hypertext systems, including the World Wide Web.

**Hypertext**
Text that allows users to go from one area to another associated area. Web browsers allow users to go from one web site to another simply by clicking on underlined words or groups of words.

**Image Map**
A single graphic image that contains more than one hot spot. Image maps are used extensively on the World Wide Web. Each hot spot in a web image map takes you to a different web page.

**Intranet**
A network based on TCP/IP. An Internet that belongs to an organization and which is accessible only by the organization's members, employees, or others with authorization. An intranet's web sites look and act just like any other web sites. Like the Internet itself, intranets are used to share information. Secure intranets are now the fastest-growing segment of the Internet because they are much less expensive to build and manage than private networks.

**I/O**
An acronym for *Input/Output* (pronounced eye-oh). Any operation, program, or device whose purpose is to enter data into a computer or to extract data from a computer.

**Java**
A powerful programming language developed by Sun Microsystems that is being used by software developers to build a variety of applications, including web pages.
**JPEG**
An acronym for *Joint Photographic Expert Group*. A method of compressing colour, bitmapped images that allows for variable degrees of compression (low, medium, high or maximum quality). There is some loss of image quality when the image is compressed and then decompressed in a browser.

**LAN**
An acronym for *Local Area Network*. A computer network that spans a relatively small area. Most LANs are confined to a single building or group of buildings. Most LANs connect workstations and personal computers. Each node (individual computer) in a LAN has its own central processing unit with which it executes programs, but it also is able to access data and devices anywhere on the LAN. This means that many users can share expensive devices, such as laser printers, as well as data. Users also can use the LAN to communicate with each other, by sending e-mail or engaging in chat sessions.

**Link**
An electronic connection between parts of a document. Sometimes the term is used in its literal sense while at other times it is used to refer to the sequence of computer commands that actually cause the connection to be made.

**MTBF**
An acronym for *Mean Time Between Failures*. MTBF ratings are measured in hours and often are used to indicate the sturdiness or reliability of hard disk drives and printers.

**Platform**
Description of the fundamental hardware and operating system software environment being used. For example, the platform might be an Intel 80486 processor running DOS Version 6.0, or PowerMac running OS 8.5. The platform also could be UNIX machines on an Ethernet network. A platform defines a standard which can be clearly communicated and to which users, developers, and organizations can conform and rely upon.

**RAID**
An acronym for *Redundant Array of Independent/Inexpensive Disks*. A category of disk drives that employs two or more drives in combination for fault tolerance and performance. RAID disk drives are used frequently on servers but are not generally necessary for personal computers.

**RAM**
An acronym for *Random Access Memory*. The most common type of memory found in computers. RAM is used to store computer programs and users' work. RAM is referred to as volatile memory since, when the computer is turned off, its content is lost.

**Real Time**
Occurring immediately. The term is used to describe a number of different computer features. For example, real-time operating systems are systems that respond to input immediately. They are used for such tasks as navigation, in which the computer must react to a steady flow of new information without interruption. Most general-purpose operating systems are not real time because they can take a few seconds, or even minutes, to react. Real time also can refer to events simulated by a computer at the same speed that they would occur in real life. In graphics animation, for example, a real time program would display objects moving across the screen at the same speed that they would actually move.
**Server**
A computer or device on a network that manages network resources. For example, a file server is a computer and storage device dedicated to storing files. Any user on the network can store files on the server. A print server is a computer that manages one or more printers, and a network server is a computer that manages network traffic.

**TCP/IP**
An acronym for *Transmission Control Protocol/Internet Protocol*. The language that allows computers to communicate on the Internet.

**Tele-**
A prefix that implies electronically mediated communication, typically, via telephone lines; e.g., teleconference, a conference between three or more people conducted via the telephone.

**Template**
A template is a blank form that shows which fields exist, their locations, and their length. Templates usually include information that either does not change or changes infrequently. For example, a letter template typically includes the corporate logo and address. A spreadsheet template is likely to include cell formats, titles, and formulas (everything possible, in fact, except the data). Generally, the intent behind a template is to pre-build a document to the maximum extent to facilitate repeated use.

**URL**
An acronym for *Uniform Resource Locator*. The address of a web site that includes the protocol used to reach the target server, the host system on which the document resides, the directory path to the document and the document filename.

**WAN**
An acronym for *Wide Area Network*. A computer network that spans a relatively large geographical area. Typically, a WAN consists of two or more local area networks.

**Web Page**
A separate screen in a web site. A web site is composed of many pages, which are HTML files that are downloaded individually. A page is scrollable and therefore spans multiple screens. Ideal page size varies according to the content and audience. Try to balance the number of graphics with reasonable download time, and strive to reduce the number of pages that need to be scrolled.

**Webmaster**
An individual who manages a web site. Depending on the size of the site, the webmaster might be responsible for any of the following:

- making sure that the webserver hardware and software is running properly,
- designing the web site,
- creating and updating web pages,
- replying to user feedback,
- writing computer programs that manage traffic through the site, and
- monitoring traffic through the site.

**Webserver**
A computer server that delivers web pages.
**Workgroup**

A workgroup is a collection of individuals working together on a task. Workgroup computing occurs when all the individuals have computers connected to a network that allows them to send e-mail to one another, share data files, and schedule meetings. Sophisticated workgroup systems allow users to define workflows so that data is automatically forwarded to appropriate people at each stage of a process.

**Workstation**

A term which implies more than just a computer. A workstation can include special purpose software as well as other devices such as printers, scanners, etc. that define the nature of the work being carried out. Some use the term to refer to a more powerful computer environment that may be required for special purpose applications such as CAD/CAM, desktop publishing, etc. More often than not, the term workstation is used synonymously with computer.
APPENDIX A
FILE NAMING CONVENTIONS

The index page is the first page viewed by your audience when they link to your site. The name of the default page is set by the webmaster. Common names used are "index.html," or "default.html." For example, St. Joe's address is the Edmonton Catholic Schools' address followed by the directory assigned to St. Joe's.

- <http://www.ecs.edmonton.ab.ca/stjoe>
- <http://www.ecs.edmonton.ab.ca/stjoe/index.html>

When you type either the first or second uniform resource locator (URL) in the address field, the browser points to the default file defined by the web server and contained in the "stjoe" folder. In this case, that file is "index.html." The advantage of saving the first page as "index.html" is that users do not have to remember or type as much information into their web browser.

Subsequent pages may be saved with an appropriate name describing the content of the page. To alleviate problems with filenames, it is a good rule of thumb to use all lowercase characters and numbers. Do not use spaces in the names of your folders or pages as certain older web browsers may not recognize them. The underscore "_" is used to facilitate reading filenames. For example, "school_info.html."

Examples:

- staff.html
  - URL to access the page
    <http://www.ecs.edmonton.ab.ca/subdomain/staff.html>

- newsjan.html
  - URL to access the page
    <http://www.ecs.edmonton.ab.ca/subdomain/newsjan.html>

The index page invariably establishes an identity for the site and draws the audience to continue exploring. It is helpful to provide an introduction, list or overview of all the categories available. Regularly updating or modifying your site encourages the audience to return often.

Make a list of all the pages that need to be created and the associated filename. This list will help the web page administration team keep track of pages on the site and make updates in the future.
Directories help organize the files. For example, you may have several files in the class projects section. Create a subdirectory (folder) called "projects" and save any files associated with class projects in this folder. If one of the files is called "grade12.html" and it is saved in the "projects" folder, the following URL would be entered to access the page: <http://www.ecs.edmonton.ab.ca/subdomain/projects/grade12.html>.
CREATING A WEB PAGE USING PUBLISHER 97

Summary

In this lesson, students will learn to design web pages complete with text, graphics and hypertext links. After adding backgrounds, navigation buttons and audio-visual effects, and revising their work based on comments from peers and teachers, students will "publish" their projects on the Internet for the entire world to see.

Objectives

To have students create and publish their own web site, expand on students' critical thinking skills as they organize information for distribution over the Internet, and define Internet terms like Image map, HTML and Hyperlink.

Prerequisite Skills

- Knows how to open a document in Microsoft Word or a word processing package and use Word's many features.
- Knows how to use Microsoft Publisher 97 and can access the World Wide Web using Microsoft Internet Explorer or Netscape Navigator.

Time Alotted

Approximately two weeks.

How to Begin

Provide a brief introduction to the Internet and explain to students that they will be creating a web site of their very own. Introduce terms they are likely to encounter as they develop pages for the World Wide Web such as Image map and Hyperlink.

Ask students about web sites or pages they visit regularly. What do they like about the content and design of these sites? Why do some home pages work and not others? What could be done to improve web page design? How important are the following web page design elements: text that is easy to read, links to other pages, pictures, animations, multimedia sounds and music, video clips, 3D elements, e-mail reply forms, interactivity? Do these elements make the web site more appealing, or are they a distraction?

Student Activity

In this activity, you will create your own World Wide Web site and "publish" your site to a folder.
Step 1: Deciding on ideas for the web site

Software: Microsoft Internet Explorer

What to do:
Think about the different kinds of information you might like to publish on your web site, such as:

- information about a science project or a social studies unit just completed,
- a class directory highlighting the diverse cultural backgrounds of the students in your school,
- a school-sponsored community web site introducing visitors to local community attractions, popular restaurants, cool clothing stores, and
- pictures from a recent class trip, along with student reports.

Use Internet Explorer to visit other school web sites for design ideas. Send e-mail messages, commenting on how you enjoyed the site or inquiring about web design techniques.

Recommended Web Sites:
- The Global Schoolhouse
  <http://www.gsh.org>
- Schools on the Web
  <http://www.web66.coled.umn.edu/schools.html>
- For an international mega-list of school sites, visit Web66 International Registry of School Web Sites.
  <http://www.web66.coled.umn.edu>

Step 2: Creating the web page

Software: Microsoft Publisher 97

What to do:
Use Publisher 97 to create single-page or multi-page web sites.

CREATING A WEB PAGE USING HTML

Summary

In this workshop you will learn to write a web page using Word 97 and view the output in Microsoft Internet Explorer. HTML tags will be introduced and the positioning of tags will be discussed. You will learn to navigate between the HTML source code and the output in Microsoft Internet Explorer. A sample web page will be produced with various formatting tags and graphics.
You will need a word processing program that allows you to save text files or HTML files. HTML is a set of special codes that you embed into text to add formatting and create links. By convention, all HTML information begins with an open angle bracket < and ends with a close angle bracket >. Most codes are paired with beginning tags (open tags) and end tags (close tags). An HTML browser such as Microsoft Internet Explorer will transform the source code into a web page.

**Basic HTML tags**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;HTML&gt;</code></td>
<td>Begins an HTML formatted document</td>
</tr>
<tr>
<td><code>&lt;HEAD&gt;</code></td>
<td>Beginning of HTML header information</td>
</tr>
<tr>
<td><code>&lt;TITLE&gt;</code></td>
<td>Places text in the title bar</td>
</tr>
<tr>
<td><code>&lt;/HEAD&gt;</code></td>
<td>End of the HEAD section</td>
</tr>
<tr>
<td><code>&lt;BODY&gt;</code></td>
<td>Beginning of main HTML text</td>
</tr>
<tr>
<td><code>&lt;/BODY&gt;</code></td>
<td>End of main HTML text</td>
</tr>
<tr>
<td><code>&lt;/HTML&gt;</code></td>
<td>Last line of an HTML document</td>
</tr>
</tbody>
</table>

**Formats**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;P&gt;</code></td>
<td>Paragraph break (does not have an end tag)</td>
</tr>
<tr>
<td><code>&lt;BR&gt;</code></td>
<td>Line break (does not have an end tag)</td>
</tr>
<tr>
<td><code>&lt;HR&gt;</code></td>
<td>Horizontal rule (does not have an end tag)</td>
</tr>
<tr>
<td><code>&lt;I&gt;</code></td>
<td>Italics</td>
</tr>
<tr>
<td><code>&lt;B&gt;</code></td>
<td>Bold</td>
</tr>
<tr>
<td><code>&lt;CENTER&gt;</code></td>
<td>Center</td>
</tr>
<tr>
<td><code>&lt;H1&gt;</code></td>
<td>Level one section heading (largest)</td>
</tr>
<tr>
<td><code>&lt;H2&gt;</code></td>
<td>Level two section heading</td>
</tr>
<tr>
<td><code>&lt;H6&gt;</code></td>
<td>Level six section heading (smallest)</td>
</tr>
<tr>
<td><code>&lt;BODY BGCOLOUR='#FFFFFF'&gt;</code></td>
<td>Sets background colour to white</td>
</tr>
</tbody>
</table>

**Graphics**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;IMG SRC='filename'&gt;</code></td>
<td>Name of the graphics file to include</td>
</tr>
</tbody>
</table>

**Links and Lists**

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;A HREF='file'&gt;</code></td>
<td>Hypertext reference to a file</td>
</tr>
<tr>
<td><code>&lt;A HREF=mailto:'email'&gt;</code></td>
<td>Hypertext reference to an e-mail address</td>
</tr>
</tbody>
</table>
How to Begin

Launch Microsoft Word and create a new document. Type the following script:

<HTML>
<HEAD>
<TITLE>First Web Page</TITLE>
</HEAD>

<BODY>
Welcome to my first web page. I am proud to be the author of a new and exciting web site!
</BODY>

</HTML>

Save your document as "first.html." (Choose SAVE AS from the FILE menu)

Save as type: Text Only (*.txt)

SAVE AS TEXT ONLY.
Minimize Word and launch Microsoft Internet Explorer. Open the file "first.html" by choosing OPEN from the FILE menu.

![Open dialog box](image)

Click on the BROWSE button.

Highlight "first.html" and click on OPEN.

![Browse dialog box](image)

BEST COPY AVAILABLE
Minimize Microsoft Internet Explorer and return to the source code in Word.

Format Text

Add the following format changes to your document:

```html
<HTML>
<HEAD>
<TITLE>First Web Page</TITLE>
</HEAD>

<BODY>
<H1>Welcome to my first web page. </H1>
<P>
<B><CENTER>I am proud to be the author of a new and exciting web site!</CENTER></B>
</BODY>

</HTML>
```

Save your changes by choosing SAVE from the FILE menu.
Return to Microsoft Internet Explorer and click on REFRESH to view the output of your document with the updated changes.

Adding Graphics

Return to the source code in Word. Make the following text changes and add a graphic to your document:

```
<HTML>
<HEAD>
<TITLE>SCHOOL NAME's Web Page</TITLE>
</HEAD>
```
Welcome to SCHOOL NAME's web page. We are proud to have a web page for SCHOOL NAME!

Choose SAVE AS from the FILE menu. Name the file "index.html" as follows:

Return to the Internet Explorer browser and OPEN the "index.html" file. (Choose OPEN from the FILE menu).
Add Links and a List

Return to the source code in Word. Include a hypertext link in your document that will link the page, "index.html," to the Edmonton Catholic Schools web page. Also add a bulleted list of contents to your web page, a horizontal rule to divide sections and an e-mail address link.

<HTML>

<HEAD>
<TITLE>SCHOOL NAME's Web Page</TITLE>
</HEAD>

<BODY>

<CENTER><IMG SRC= "ecs_logo.gif"></CENTER>

<H1><CENTER>Welcome to SCHOOL NAME's web page. </CENTER></H1>

<P>
<B><CENTER>We are proud to have a web page for SCHOOL NAME! </CENTER></B>

<UL>
<LI>General Information
<LI>Upcoming Events
<LI>Academics
<LI>Extracurricular
<LI>School Advisory Council
</UL>

<HR>

<A HREF= http://www.ecs.edmonton.ab.ca>Return to ECS web page</A>

<br>

<A HREF=MAILTO:brownb@ecs.edmonton.ab.ca>E-mail to B. Brown</A>
Save the changes to your document. Return to Internet Explorer and click on REFRESH.

EDMONTON CATHOLIC SCHOOLS

Welcome to SCHOOL NAME's web page.

- General Information
- Upcoming Events
- Academics
- Extracurricular
- School Advisory Council

Return to ECS web page
Email to B. Brown

Now try the link to the ECS web page. Were you successful?

This is only an introduction to creating web pages from scratch.

CREATING A WEB PAGE WITH WORD 97

Word processing packages such as Word 97 allow you to save your work in an HTML file format.

Create a folder to save your web page(s), graphics, sounds, etc.

Double click "My Computer."

Double click drive D:

Choose File → New Folder
Name the folder "My Web Page."

Start a new document. Type the text for your page and make format changes as desired.

For example, change the font, type size or justification.

Save frequently.

Choose File → Save As HTML

Use the name "index.html" for the first page you want your audience to view.
Open Existing Templates or Files

Launch Word
Choose File → Open
Select the template or file you would like to modify and click on the Open button.

**Note:** If you double click on the file name without being in Word, the file (HTML) will launch using Internet Explorer. In this case, click on the EDIT button to make changes to the file.

Insert graphics.

Choose Insert → Picture → From File

Copying graphics from the Web: Right click on a picture and choose Save Picture As...
Save in "My Web Page" folder.

Change the background colour.

Choose Format → Background

Create a list.

Select numbering or bullets from the list types. Type your list.

Create links to other pages.

Type the address (URL) of the page you would like to create a link to.
Example: <http://www.ecs.edmonton.ab.ca>

Or:
Type a title and highlight. Example: "Edmonton Catholic Schools."

Choose Insert → Hyperlink and

Link to file or URL and type <http://www.ecs.edmonton.ab.ca>

Create an e-mail address link.

Type a title and highlight. Choose Insert → Hyperlink and Link to file or URL and type mailto: brownb@ecs.edmonton.ab.ca (the e-mail address of the recipient).
Check your web page in Microsoft Internet Explorer.

Always view your web page in the browser. Click on the WEB PAGE PREVIEW button to automatically launch Microsoft Internet Explorer and preview your page.

After checking the page, Click on the EDIT button in Microsoft Internet Explorer to return to Word 97. This automatically opens Word and allows you to continue working on your web page.

Or:

Save the page and any other linking pages. Minimize Word. Launch Internet Explorer. Choose OPEN/FILE and select the file you saved.

Click on the REFRESH button to view changes to your web page.

Minimize Internet Explorer and return to Word to continue working on your web page.

Or:

Press ALT+TAB to toggle back and forth between Word 97 and Internet Explorer. Click on the REFRESH button to update any changes made to your page.
Once the page is complete and you have checked for errors, you are ready to transfer the page to the web server.

POINTS OF INTEREST RESOURCES

- This is a template that may be modified for a school web page.  
  [http://www.ecs.edmonton.ab.ca/template]

- This is the ECS logo followed by the words “Edmonton Catholic Schools.”  
  [http://www.ecs.edmonton.ab.ca/template/ecs_logo.gif]

- This is the transparent ECS logo.  
  [http://www.ecs.edmonton.ab.ca/template/ecs_logo_pic.gif]

- Text only of “Edmonton Catholic Schools.”  
  [http://www.ecs.edmonton.ab.ca/template/ecs_logo_text.gif]

- WWW Page Construction resources  

- Randy Ralph’s Fabulous Graphics (Free Graphics, Animations, etc.)  
  [http://www.iconbazaar.com]

- The Icon Browser  
  [http://www.cli.di.unipi.it/iconbrowser/icons.html]

- Special Characters  
  [http://www.w3.org]

- Icon City  
  [http://www.yoink.com/iconcity/icons.htm]

RESOURCES FOR TEACHERS

*Web Development* from The Essentials (CTS Publishing) [www.essentials.ab.ca] is an excellent CD resource for teachers. It contains student and teacher files that provide excellent lessons for meeting learner outcomes related to web development. Two Alberta educators, LeAnn Whaling and Dean McKinney, developed this product.

On-line help is available on the Web Design Listserv, where people share questions and concerns about web site development.  
Send an email to: webpages@strc.ecs.edmonton.ab.ca  
Subject: subscribe.
APPENDIX C
RELATED ALBERTA EDUCATION RESOURCES


NOTICE

REPRODUCTION BASIS

☑ This document is covered by a signed "Reproduction Release (Blanket) form (on file within the ERIC system), encompassing all or classes of documents from its source organization and, therefore, does not require a "Specific Document" Release form.

☐ This document is Federally-funded, or carries its own permission to reproduce, or is otherwise in the public domain and, therefore, may be reproduced by ERIC without a signed Reproduction Release form (either "Specific Document" or "Blanket").